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Notice Every effort was made to ensure that the information in this document 
was accurate at the time of printing. However, information is subject to 
change without notice, and JDSU reserves the right to provide an 
addendum to this document with information not available at the time that 
this document was created.

Copyright © Copyright 20011 JDSU, LLC. All rights reserved. JDSU, Enabling 
Broadband and Optical Innovation, and its logo are trademarks of JDSU, 
LLC. All other trademarks and registered trademarks are the property of 
their respective owners. No part of this guide may be reproduced or 
transmitted electronically or otherwise without written permission of the 
publisher.

Trademarks JDSU and MTS/T-BERD 2000 are trademarks or registered trademarks 
of JDSU in the United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet 
Explorer are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Netscape Navigator is a trademark or registered trademark  of Netscape 
Communications Corporation in the United States and other countries.

Specifications, terms, and conditions are subject to change without 
notice. All trademarks and registered trademarks are the property of their 
respective companies.

Ordering
information

This guide is a product of JDSU's Technical Information Development 
Department, issued as part of the User Manual. The ordering number for 
a published guide is E2000M02.

WEEE Directive
Compliance

JDSU has established processes in compliance with the Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2002/96/EC.

This product should not be disposed of as unsorted municipal waste and 
should be collected separately and disposed of according to your 
national regulations. In the European Union, all equipment purchased 
from JDSU after 2005-08-13 can be returned for disposal at the end of 
its useful life. JDSU will ensure that all waste equipment returned is 
reused, recycled, or disposed of in an environmentally friendly manner, 
and in compliance with all applicable national and international waste 
legislation.
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It is the responsibility of the equipment owner to return the equipment to 
JDSU for appropriate disposal. If the equipment was imported by a 
reseller whose name or logo is marked on the equipment, then the owner 
should return the equipment directly to the reseller.

Instructions for returning waste equipment to JDSU can be found in the 
Environmental section of JDSU’s web site at www.jdsu.com. If you have 
questions concerning disposal of your equipment, contact JDSU’s 
WEEE Program Management team at WEEE.EMEA@jdsu.com.
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About This Guide

The 2000 Platform of JDSU provides a handhled modular platform 
designed for the construction, turn-up and maintenance of fiber 
networks.

The topics discussed in this chapter are as follows:

– “Purpose and scope” on page xvi

– “Assumptions” on page xvi

– “Technical assistance” on page xvi

– “Conventions” on page xvii
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Purpose and scope

xvi User Manual 790000002/00

Purpose and scope
The purpose of this guide is to help you successfully use the 2000 Plat-
form features and capabilities. This guide includes task-based instruc-
tions that describe how to install, configure, use, and troubleshoot the 
2000 Platform. 

Additionally, this guide provides a complete description of JDSU’s 
warranty, services, and repair information, including terms and condi-
tions of the licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users 
who want to use the 2000 Platform effectively and efficiently. We are 
assuming that you have basic computer and mouse/track ball experience 
and are familiar with basic telecommunication concepts and terminology.

Technical assistance 
If you need assistance or have questions related to the use of this 
product, call or e-mail JDSU’s Technical Assistance Center for customer 
support.

Table 1 Technical assistance centers

Region Phone Number

Americas
Telecom Products

866 228 3762
World Wide: 301 353 1550

tac@jdsu.com

Europe, Africa, and 
Mid-East

+49 (0) 7121 86 1345
(Europe)

hotline.europe@jdsu.com

+33 (0) 1 30 81 50 60
(JDSU France)

support.france@jdsu.com

Asia and the Pacific
Southeast Asia, Aus-
tralia, and New Zea-
land

+852 2892 0990
(Hong Kong)

+86 10 6833 7477
(Beijing-China)

All others 866 228 3762 tac@jdsu.com
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During off-hours, you can request assistance by doing one of the 
following: 

– leave a voice mail message at the Technical Assistance number in 
your region

– e-mail North American Technical Assistance Center, tac@jdsu.com, 
or European Technical Assistance Center, support.uk@jdsu.com

– submit your question using our online Technical Assistance Request 
form at www.jdsu.com.

Conventions
This guide uses naming conventions and symbols, as described in the 
following tables.

Table 2 Typographical conventions

Description Example

User interface actions appear in 
this typeface.

On the Status bar, click Start.

Buttons or switches that you 
press on a unit appear in this 
TYPEFACE.

Press the ON switch.

Code and output messages 
appear in this typeface.

All results okay

Text you must type exactly as 
shown appears in this type-
face.

Type: a:\set.exe in the dia-
log box 

Variables appear in this type-
face.

Type the new hostname

Book references appear in this 
typeface. 

Refer to Newton’s Telecom 
Dictionary

A vertical bar | means “or”: only 
one option can appear in a sin-
gle command.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group 
required arguments.

<password>
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Table 4 Symbol conventions

Table 5 Safety definitions

Table 3 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simulta-
neous keystrokes.

Press Ctrl+s

A comma indicates consecutive 
key strokes.

Press Alt+f,s

A slanted bracket indicates 
choosing a submenu from 
menu.

On the menu bar, click 
Start > Program Files.

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging 
indicates that the equipment must not be disposed of in a land-
fill site or as municipal waste, and should be disposed of 
according to your national regulations.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.
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Chapter 1 2000 Platform Overview

This chapter provides a general description of the 2000 Platform.

Topics discussed in this chapter include the following: 

– “Unpacking the instrument” on page 2

– “About the 2000 Platform” on page 2

– “Main features” on page 3

– “Hard keys and Indicators” on page 5

– “Power Supply” on page 7
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Unpacking the instrument
1 Remove the 2000 Platform and its accessories from the packing 

case.

2 Check that the module and accessories ordered are all there.

If any part is missing or damaged please contact your local JDSU agent.

The 2000 Platform is delivered as standard with:

About the 2000 Platform
The architecture of the 2000 Platform is made of one Platform, to which 
a module can be added to perform tests on fiber networks.

The modules that can be fitted to the 2000 Platform are interchangebale 
in the field and different kinds of module are usable:

– OTDR Modules

– PON Selective Power Meter (OLP)

– CWDM Analyzer Modules (C-OSA)

The 2000 Platform employs multi-tasking for the simultaneous perfor-
mance of several operations:

– acquisitions

– modifications of parameters

– trace analysis

– report management

Table 1 Elements delivered on standard with the 2000 Platform

A Getting Started Manual

A Li-Polymer battery, set into the equipment and which must be 
charged before use

A mains adapter used for mains operation of the instrument and 
battery charging 

5 country adaptable plugs (Europe / UK / US / Australia / Japan)

A hands-free soft case for the 2000 Platform

A USB cable, to directly connect the 2000 Platform to a PC

A shoulder strap
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It also allows to use simultaneously several functions:

– Power Meter

– Scope

– OTDR measurements...

Main features
The 2000 Platform is equipped with the following elements:

– A 5 inch TFT color touchscreen, high visibility

– RJ45 plug for Ethernet interface

– Two USB 2.0 host connectors for Microscope, USB memory stick, 
mouse, keyboard, ...

– One mini USB 2.0 device connector to connect the 2000 Platform to 
a PC

– An audio jack to connect a headset

– A connection socket for the mains adapter providing the 12 V power 
supply and used to charge the battery.

– LED indicators for Charge, On status and Test

– A Li-Polymer battery

– A module interchangeable in the field: OTDR, OLP, or C-OSA.

– Built-in Power Meter, VFL and/or Talkset (options)

With the 2000 Platform, the user can:

– Open and/or transfer files to a PC via a USB memory stick, USB 
cable or Bluetooth (option)

– Generate pdf reports

– Open all user documentations included into the 2000 Platform

– Update the 2000 Platform firmware

– Remote the screen of the 2000 Platform onto a PC and issue 
commands from the keyboard of the PC

– ...
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Fig. 1 2000 Platform with module

Fig. 2 2000 Platform: Front view

Fig. 3 2000 Platform: Connectors View

Hardkeys

Indicators

Loudspeaker

TFT 5’’ Color 
Touchscreen

RJ45 USB host Power Meter VFL Mini USB 
device

AC/DC 
Input

Headset jack

2000 Platform English rev00.book  Page 4  Lundi, 20. juin 2011  1:47 13



Chapter 1 2000 Platform Overview
Hard keys and Indicators

User Manual 790000002/00 5

Hard keys and Indicators

Front panel
hard keys

Fig. 4 Hard keys and Indicators

Table 2 Hard keys description

Hardk
ey

Function

Main on/off switch

This button calls up the file explorer. It allows to:

– choose the storage medium: internal memory, USB 
memory key..

– manage files; with facilities for classifying them in direc-
tories and sub-directories.

Gives access to:

– selection of the different measurement or functions

– the settings of the instrument

– the help page

This button calls up the measurement configuration menu. 
This menu depends on the function in use.

This button allows to deselect a function or escape a 
menu

Starts and stops the measurement.

This button calls up the results page (e.g. with OTDR 
module: reflectometry trace and table of results).
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The direction keys have two principal functions:

Front panel
indicators

The  2000 Platform is equipped with three indicators, lit into a different 
color acccording to the status of the unit.

NOTE

All these functions, except HOME, depend on the modules used and 
the measurements made: refer to the user manuals of the corre-
sponding modules of the 2000 Platform.

– on the Results page, they are used to move the cursors or 
modify the zoom factor.

– on the set-up pages, they are used to scroll through the 
menus, the central button serving to select or confirm the 
parameter chosen.

Table 3 Indicators Status

On indicator

 Blicking green
The instrument, though connected to an 
external power source, is switched off.

Solid green
The instrument is operating, either by battery 
or on an external power supply.

Charge indicator

Solid green
The instrument is connected to an external 
power source and the battery is fully 
charged.

Solid red
The instrument is connected to an external 
power source, and the battery is on charge.

Testing indicator

Solid red
At least one function is in measurement 
phase (for example, the laser emission pilot 
for an OTDR measurement)
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Power Supply
The 2000 Platform may operate with

– the Li-Polymer battery, already set into the equipment on delivery.

– an AC adapter/charger, via a power cable on which has been set the 
correct country adaptable plug.

Fig. 5 Delivered elements for 2000 Platform supplying

Interchangeable plugs

Power supply plug

UK adaptable plug 
(installed by default)

EUROPE 
adaptable plug

US
adaptable plug

JAPAN
adaptable plug

AUSTRALIA
adaptable plug
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Chapter 2 Safety information

This chapter gives the main information on the safety conditions when 
using the 2000 Platform:

– “Battery and AC/DC safety information” on page 10

– “Precautions relating to optical connections” on page 10

– “Laser Safety instructions” on page 11
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Battery and AC/DC safety information
– The Li-Polymer battery is designed for maximum safety.

In particular, each cell is provided with a safety valve to prevent exces-
sive internal pressure in the event of overcharging or exposure to very 
high temperatures.

– Battery supplied by JDSU incorporate protection means.

Do not use any mains adaptor or battery other than those supplied with 
the instrument, or supplied by JDSU as an option for this instrument.

If another adapter or battery is used, it may damage the 2000 Platform 
itself.
Using the 2000 Platform with a battery other than the one supplied by the 
manufacturer of the 2000 Platform may entail risks of fire or explosion. 

The battery may explode, leak or catch fire:

– if it is exposed to high temperature or fire

– if it is opened or dismantled.

Other basic safety precautions are as follows:

– Do not use AC/Adapter/Charger outdoors or in wet or damp loca-
tions

– Connect the AC/Adapter/Charger to the correct mains voltage, as 
indicated on the ratings label.

– Do not allow anything to rest on the power cord, and do not locate 
the product where people can walk on the power cord.

– Avoid using this product during an electrical storm. There may be a 
remote risk of electric chock from lightning.

– Do not use this product in the vicinity of a gas leak or in any explo-
sive environment.

– Do not attempt to service this product yourself, as opening or 
removing covers may expose you to dangerous, high voltage points 
and other hazards. Contact qualified service personnel for all 
service.

Precautions relating to optical connections
– The normal operating life of an optical connector is usually of the 

order of a few hundred manipulations. It is then advisable to manip-
ulate the optical connections of the Platform as rarely as possible.

– The proper operation of the instrument and its accuracy of measure-
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ment are dependent on the cleanliness of the environment and the 
optical connectors as well as the care taken in its manipulation.

– The optical connectors must therefore be clean and dust-free. If the 
optical connection is not being used, protect the connections of 
2000 Platform using the protective caps.

Laser Safety instructions
The provisions contained in two standards define the safety procedures 
to be observed both by users and by manufacturers when utilizing laser 
products:

– EN 60825-1: 2001 - Safety of laser products – Part 1: Classification 
of products, requirements and user guidelines. 

– FDA 21 CFR § 1040.10 - Performance standards for light-emitting 
products - Laser products.

Due to the range of possible wavelengths, power values and injection 
characteristics of a laser beam, the risks inherent in its usage vary. The 
laser classes form groups representing different safety thresholds.

Laser classes Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10: 

– VFL option: Class 2.

Warning labels
for the laser

classes

Due to the reduced dimensions of the optical modules, it is not possible 
to attach the required warning labels to them. In line with the provisions 
of Article 5.1 of the EN 60825-1 standard, the laser class identification 
labels are shown below:

The user must take the necessary precautions concerning the optical 
output of the instrument and follow the manufacturer’s instructions.

Reference 
standard

EN 60825-1, Edition 1.2, 2001-08 FDA21CFR§1040.10

Class 1

Class 2

CLASS 1
LASER PRODUCT

LASER RADIATION
DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT

LASER RADIATION - DO 
NOT STARE INTO BEAM 

CLASS II LASER PRODUCT

CAUTION

Measurements on optical fibers are difficult to execute and the 
precision of the results obtained depends largely on the 
precautions taken by the user.
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Chapter 3 Starting up

This chapter describes the first steps to perform when using the 2000 
Platform.

The topics discussed in this chapter are as follows:

– “Fitting and removing a module” on page 14

– “Setting the adaptable plug to the mains adapter” on page 15

– “Charging the battery” on page 16

– “Switching the 2000 Platform on and off” on page 17

– “First start: configuring your regional settings” on page 18
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Fitting and removing a module

Fitting a
module

1 Turn the instrument face down on the work surface.

2 Set the two notches on the module part (1a) into the two holes 
provided for that purpose on the Base (1b).

3 Make flush the 2 connections (2a & 2b), on module and base.

4 Once positioned, fix the module to the base screwing the 2 screws 
(3a) fixing the receptacle.

Removing a
module

1 Unscrew the two captive fixing screws of the module completely (up 
to the stop).

2 Remove the two slots of the module from their housing onto the 
base.

3 Carefully remove the module out of its slot.

The 2000 Platform must be switched off, and if it is operating on 
the mains, its supply cable must be unplugged.

Fig. 6 Fixing the module to the base

Captive screws fixing the module

1b
1b

2a

2b

2000 Platform with module installed

2000 Platform without module

1a
1a

3a
3a
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Setting the adaptable plug to the mains adapter
The 2000 Platform is supplied as standard with a mains adapter and 5 
country adaptable plugs (Europe / UK / US / Australia/Japan).

To set the correct plug to the mains adapter:

1 Make flush the connector onto the mains adapter with the adaptable 
plug slots.

2 Push the adaptable plug until it stops.

Fig. 7 Setting the adaptable plug onto the mains adapter

1

2 3

If the adapter plug is not correctly set onto the mains adapter, 
the connector may be damaged.
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Charging the battery

Connecting the
mains adapter

1 Set the appropriate adaptable plug to the power supply cable, 
according to your country (see page 15).

2 At the right side of the 2000 Platform, lift up the power supply socket 
protector and plug in the mains adapter. 

3 Connect the adapter to the mains. 

The On indicator lamp starts to blink in green.

First use of the
battery

At the delivery, the battery is already set into the Platform, but its charge 
level is not «recognized» by the equipment. 

The icon  is displayed on the upper banner of the screen.

To get a valid indication of the battery, and be able to use correctly the 
Platform:

1 Charge fully the battery

2 Once fully charged, discharge the battery by keeping the Platform 
switched on, but not plugged to mains.

3 The battery can then be charged, and the Platform used simultane-
ously.

Charging the
battery

On connection to the mains:

– if the user does not press ON, the battery will start the charge. In this 
case, the Charge indicator will be lit in red. 

– when the user presses the ON key, the instrument starts up and the 
battery will charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is 
not compatible with the battery used. Charge is disabled.

Use only the mains adapter supplied with the 2000 Platform. The 
adapter for some other electronic device may appear to be 
identical, but entails a risk of damage to the 2000 Platform.

It is essential to wait until charging is complete to ensure 
maximum independent operating time, which may otherwise be 
considerably reduced.
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Battery
charging time

If the battery is completely discharged, the time taken to recharge is:

– approximately 3.5 hours, if the apparatus is not in use (Charge indi-
cator solid red)

– about 9.5 hours if the instrument is used during charging (On indi-
cator lit in fix green, Charge indicator lit in solid red).

Battery charge
level display

When the battery is installed in the instrument, a battery icon is displayed 
in the top right-hand corner of the screen. Example: .

– When the level becomes too low, the instrument emits a beep ton 
inform the user until it switches off automatically after saving the 
current configuration and measurement.

Switching the 2000 Platform on and off

Switching on
the 2000
Platform

1 Press the ON/OFF key.

If the Platform is powered to mains, the battery will charge.

The On indicator pass from blinking to solid green. 

Table 4 Battery icons

The battery capacity is superior to 75%

The battery capacity is set between 50% and 75%

The battery capacity is set between 25% and 50%

The battery capacity is inferior to 25%

The battery capacity is unknown. Perform a full charge/
discharge of the battery to get back to a valid indication.
This icon may appear if battery is changed or if the bat-
tery auto discharges at a very low level (example: if a 
Platform switches off as battery is empty, and the charge 
is not done during several months (= auto discharge)).
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The JDSU logo appears on the screen briefly, then an autotest is 
carried out.

The equipment is ready to be used once all the applications are 
installed.

Switching off
the 2000
Platform

While the 2000 Platform is operating, press the ON/OFF button to switch 
it off.

Resetting the
2000 Platform

If the 2000 Platform freezes, prolonged pressure (about 4 s.) on the ON/
OFF key will reset the instrument.

First start: configuring your regional settings
Once the 2000 Platform is switched on, the first screen displayed allows 
to configure the regional settings.

Those settings will be kept in memory and automatically applied on the 
instrument each time it is restarted.

NOTE

It is possible to switch over from battery to mains operation, or vice 
versa, without loss of data.

The module cannot be swapped when the unit is ON or AC 
powered

In the event of an unexpected mains power cut, if there is no 
battery, the current results and configuration will not be saved. 
Next time the instrument is switched on, it will return to its initial 
configuration.

NOTE

When the instrument is switched off using the ON/OFF button, current 
results and configuration are saved. Next time the ON/OFF key is 
pressed, they are recalled.
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1 Click on Language and select the language to be used for the 
equipment.

2 Click on Date and enter the current date, using the numeric keypad 
displayed using the menu key Edit Number.

3 Click on Time  and enter the current time, using the numeric keypad 
displayed using the menu key Edit Number.

The date and time are displayed on the upper right side of the 
screen.

4 Click on Date Time Format and configure the following parameters:

– Date format: select one of the option dd/mm/yy or mm/dd/yy.

– Time format: select one of the option 24 hour clock or 12 hour 
clock.

5 Once all parameters have been defined, press Exit menu key.S to 
reach the System Settings page.

Fig. 8 Regional Settings
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Chapter 4 Configuring the 2000 Platform 

This chapter describes the operations for configuring the instrument.

The topics discussed in this chapter are as follows:

– “Displaying the System Settings screen” on page 22

– “Defining the screen parameters of the 2000 Platform” on page 23

– “Defining the Audio parameters of the 2000 Platform” on page 24

– “Defining the Automatic shutdown of the 2000 Platform” on page 24
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Displaying the System Settings screen
To display the System Settings screen, you must:

1 Press the HOME hard key to reach the Home page.

2 Activate the Settings icon to open the System Settings 
screen.

Fig. 9 Home page

Fig. 10 System Settings page

NOTE

If you are in the Regional Settings page, and you press Exit, then the 
System Settings page automatically displays.

2000 Platform English rev00.book  Page 22  Lundi, 20. juin 2011  1:47 13



Chapter 4 Configuring the 2000 Platform
Defining the screen parameters of the 2000 Platform

User Manual 790000002/00 23

Defining the screen parameters of the 2000 Platform
In the System Settings page, the following parameters can be defined:

Backlight 1 Click on Backlight 

2 Define the backlight level of the screen, using the left and right 
direction keys, or clicking on Edit Number softkey and using the 
keypad displayed.

– Min backlight level: -5

– Max backlight level: +5

Contrast 1 Click on Contrast

2 Select the type of environment into which the instrument is used:

– Indoor: to be selected when the instrument is used inside (see 
Figure 10 on page 22)

– Outdoor: to be selected in order to optimize the readability of 
the screen for an outside use.

Screen Saver Click on Screen Save if you wish to activate a screen saver to the equip-
ment, to extend the life of the battery, in case the 2000 Platform is not 
used for some time.

Instead of the normal screen, a small animated picture of the 2000 Plat-
form is displayed on the blackened screen. 

If the 2000 Platform is operating on battery, it is advisable to 
choose a minimum lighting level, acceptable for the user, to keep 
endurance as long as possible.

Fig. 11 Example of outdoor contrast
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To configure the screen saver:

1 Click on Delay and select the time of inactivity before 
the screen saver starts: 60s, 3 min, 5 min.

The parameter No deactivates the screen saver func-
tion.

Defining the Audio parameters of the 2000 Platform
In the Audio box of the System Settings screen, you can configure the 
audio parameters according you are using a headset with the 2000 Plat-
form.

1 Adjust the volume on the line Hands-free Volume using the left and 
right direction keys, or the Numeric keypad (displayed with the 
softkey Edit Number)

– Min volume for Hands-free function: 0

– Max volume for Hands-free function: 100

2 If a headset is used, adjust the volume on the line Headset Volume, 
using the left and right direction keys, or the Numeric keypad 
(displayed with the softkey Edit Number):

– Min volume for Headset function: 0

– Maxvolume for Headset function: 100

Defining the Automatic shutdown of the 2000 Platform
The automatic shutdown function switches off the 2000 Platform auto-
matically if no operation has been performed and no key actuated for a 
period selected from this menu. Work in progress is automatically saved.

1 In the Utility box, click on Auto off parameter.

2 Choose a time after which the 2000 Platform will be switched off 
automatically, if no action has been done for that period: 5, 10 or 30 
minutes.

Select No if the 2000 Platform must not be switched off, even if there is 
inactivity on the equipment.

The function for automatically switching off the 2000 Platform is 
available only on battery operation, to save the battery.
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Chapter 5 Power meter, VFL (Visual 
Fault Locator) & Talkset

A variety of built-in optical options are available when ordering. See 
references in Chapter 10 “Options and accessories”, for details.

The topics discussed in this chapter are as follows:

– “Connection to the power meter, VFL and Talkset” on page 26

– “Using the Power meter” on page 26

– “VFL Function” on page 31

– “Storing and reloading results” on page 32

– “Talkset Function” on page 33
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Connection to the power meter, VFL and Talkset

The type of optical connector used for the power meter is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.)

Using the Power meter
The power meter function is an option chosen at the time of order and 
incorporated into the 2000 Platform in the factory.

To activate the function:

1 Press the HOME button

2 Activate the power meter icon of the Platform  . 

The effect of this action will to be to bring the power meter into use 
and to display the Results page for Power Meter.

Configuring the
power meter

Configuring
measurement

parameters

The measurement parameters can be accessed with the SETUP key.

Fig. 12 Optical connectors

Power meter 
optical connection

VFL

Accuracy of measurements

A high degree of accuracy is often required. It is then necessary to 
perform a preliminary calibration without the fiber under test to elimi-
nate the losses due to connections as far as this is possible. To do 
this, use the «Reference Value» function.
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Wavelength Selecting wavelength:
- Auto: the wavelength of the input signal will be
automatically detected and selected to perform
the measurement:
850, 980, 1300, 1310, 1420, 1450, 1480, 1490,
1510, 1550 or 1625 nm: measurement performed
at specified wavelength.
- User: choice of wavelength on the next line

User choice (if the User option was selected in the Lambda
line) enter the wavelength between 800 and
1650 nm, using the numeric keypad, displayed
via the Edit Value key..

Beep on Modulation Select if a sound must be heard when a
modulation occurs (Yes / No)

Unit Unit of power displayed:

- Watt, dBm for displaying absolute power

- dB for displaying a result relative to a reference
(link loss)

Reference level If dB units were chosen in the previous line,
selection of the reference value for the
wavelength selected. First select the wavelength,
then press the > key to access choice of the
value (+XXX.XX).

This reference is also automatically available, in
the Results page, using the Set as Reference
key.

Attenuator compensation
Choice of level to be applied to the wavelength
chosen for measurement to compensate for the
loss due to the external attenuator (+XX.XX dB).
First use the direction keys to choose the

Fig. 13 Configuration of power measurement
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wavelength, then press > to access choice of
value.

Configuring the
alarm parameters

of the power meter

Alarm Activation of the Alarm function : any result below
the lower threshold or above the upper threshold
will be displayed in red on the Results page.

Min and max thresholds :

Choice of lower and upper thresholds for each
available wavelength, from -60 to +40 dBm
(selected with the direction keys).

Display of
results and
commands

The results page called up by the RESULTS button, gives the information 
relating to the measurement in progress, results previously saved and 
the commands available for measurement and saving.

Result of the
measurement in

progress

The power measured by the power meter is displayed in large charac-
ters, in the units selected in the SETUP menu, together with:

– the mode of transmission of the signal measured: continuous (CW) 
or modulated to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

– the wavelength of the signal measured. 

– the reference level expressed in dB.

– the level of Attenuation Compensation.

Table of results For one and the same fiber, the power meter displays a table of 9 results 
corresponding to the different possible wavelengths. The first 4 results 
are displayed on the screen; to scroll through the other results, use the 

NOTE

To copy a Reference Level or a Attenuator Compensator on all wave-
lengths, select the reference wavelength and click on Update for All 
Wavel..

NOTE

To copy one value of the Lower or/and Upper threshold for all wave-
lengths, select the reference value and click on Update for All 
Wavel..

NOTE

A continuous push on direction keys increments the value by 10 dBm.
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direction key . The table shows the power measured in dBm, the rela-
tive power (in dB) and the reference level in dBm (if units = dB), together 
with the mode.

– A measurement result is displayed in the table when the Keep 
Result softkey is pressed. 

– The Clear Table softkey orders deletion of all the results displayed 
in the table. 

– If the Alarm function has been activated, any result that exceeds the 
selected thresholds appears in red in the table. Otherwise, results 
are shown in the table in green.

– When the instrument is switched off, results present in the table are 
saved.

Commands of the
power meter
parameters

When the LTS function is selected, the following softkeys are available 
on the results page:

Keep Result Saves the result on the corresponding line of the
table.

Clear Table Deletes all the results recorded in the table.

Pressing the Powermeter Config. key allows to reach the following 
function:

Wavelength Allows to modify the wavelength to be applied
with the Power meter.

Unit Allows to modify the unit of power displayed (dB,
dBm, nW) 

Zero Adjustment of the Zero value when the power
meter’s optical input is closed with a plug (a
validation is required).

Click on Exit to go back to the Results page.

Pressing the Pow. Reference key allows to reach the following function:

Fig. 14 Results and commands of the power meter

Results
of  the
power meter
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Standard Reference Selects the current result as reference value to
measure the attenuation of a link. This reference
is displayed under the measurement result until a
new reference value is chosen.

Jumper Reference This key can be pressed when a reference in
loopback mode must be performed (see 2100
Module Series User Manual).

Performing a
measurement

The power meter is started up as soon as the function  is acti-
vated in the HOME menu.

Power
measurement

1 Connect the light source to be tested to the rear connector (see 
"Connection to the power meter, VFL and Talkset" page 26).

2 In the SETUP menu, choose the units dBm, dB or Watts.

3 Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in 
the table (see "Table of results" page 28).

4 Press the START/STOP key to stop the measurement.

Optical link loss Setting the zero value of the power meter

1 Fix the plug over the optical input of the power meter so that no light 
can reach the photodiode of the power meter. If the zero adjustment 
is made without this plug, an error message may be displayed, as 
the photodiode will detect too much light.

The soft key Jumper Ref is displayed in grey and cannot be 
activated if both power meter and Source are selected onto the 
OTDR Module set into the Platform.
The power meter must be selected onto the Base-Unit, and the 
Source onto the OTDR Module to activate the soft key and be 
able to perform a reference measurement in loopback mode.

Power measurement is automatically updated in consequence. The 
value «<-60 dB» is displayed when the laser is switched off and if the 
source output is looped on to the power meter input.

It is important to set the zero of the power meter before making any 
measurements where accuracy is required, as the noise from the ger-
manium photodiode fluctuates over time and with variations in tem-
perature.
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2 In the Results page, press the Powermeter Config. > Zero soft key 
and validate.

Carrying out the reference measurement

1 Fix the adapter corresponding to the jumper to the optical connector 
of the power meter.

2 Connect the jumper between the input of the power meter and the 
output of the source.

3 Configure the same wavelength on the source and the power meter.

The power measured is displayed in the results page of the power 
meter.

4 Press the Pow Reference > Standard Ref soft keys to save the 
result displayed as reference value.

Measurements on the fiber under test

After defining the reference value, proceed as follows to make the 
measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be 
tested between the source output and the power meter input.

2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the 
optical loss of the link tested. It can be displayed in the table (see 
"Table of results" page 28).

VFL Function

VFL connector The type of optical connector used for the VFL source is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.)

See Figure 12 on page 26 to visualize the VFL connector.

Visual Fault
Locator

function (VFL)

This function is used to emit a red light signal of frequency 1 Hz or in 
continuous mode into a fiber to detect any defects in the dead zone of the 
reflectometer, or to identify it. 

This function is suitable for short fibers (length < 5 km) or the first few 
metres of a long fiber.
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To emit a light signal into a fiber:

1 Connect the fiber to the VFL port on the connectors panel.

2 Press the HOME key and  activate the VFL 

The icons  display on the upper banner of the screen.

The signal mode of the VFL can be modified in the System Settings 
page, in Utility > VFL Mode parameter.

Storing and reloading results

File Setup Click on the button FILE to access the File setup. See the chapter «File 
management» in the user manual «2100 modules series» for a complete 
description of all parameters, options and description of the explorer.

Storing results In order to save the results of a measurement, click on FILE and select 
Store trace. Two files are being saved :

– The first file is used with the 2000 Platform and allows to retrieve all 
measurement results. It is saved with the extension «.Lts».

– The second file is a ASCII file using tabulations to separate values. 
It is saved with the extension «.txt» and can be opened by the 2000 
Platform. It has been designed to be used with a spreadsheet 
program on a PC where it allows to retrieve all measurement results 
and format them in a nice customized table. 

Loading results In order to load the results of a measurement, select a file  with the 
extension «.Lts» in the file explorer (see the chapter «File management» 
in the user manual for «2100 modules series»), click on Load then 
Confirm Load. 
The LTS tab is displayed with the loaded results in the table

NOTE

Identification is facilitated by the blinking of light in the fiber.
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Talkset Function
The Talkset option enables two operators at opposite ends of an optical 
link to communicate along the fiber. Each end of the optical link must be 
provided with a 2000 Platform equipped with the Talkset option.

Talkset
configuration

The talkset configuration is set in the System Settings screen, in the 
Channel box (see "Defining the Audio parameters of the 2000 Platform" 
page 24)

Connections At each end of the fiber: 

1 Connect the fiber to the Talkset port of the 2000 Platform, either 
directly or through jumpers.

2 A headset (with earphones and a microphone) supplied with the 
option may also be plugged into the 2000 Audio jack.

Establishing
communication

On the caller 2000 Platform, press the HOME button, then validate the 
Talkset option:

n
NOTE

It is possible to use the talkset of the 2000 Platform and to carry out 
measurements at the same time, on a different fiber.

JDSU recommends you to use the following connections:

- PC Fiber Connection (APC is not recommended)

- SC or FC connection (UPP is supplied but not recommended).

Fig. 15 Installation for Talkset use
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– If the remote instrument is ready to receive (on standby), the Talkset 
icon turns orange, beeps are emitted, and the icon  appears at 
the top of the screen: telephone communication can now take place. 

– If the remote instrument is not ready to receive, the Talkset icon 
does not change color and a message is emitted.

Adjusting
volume level

The sound is transmitted to the earphones of the headset and, if this 
function has been activated, to the speaker in the 2000 Platform base. To 
activate the base loudspeaker and adjust the volume:

1 Press the HOME key.

2 Validate Settings icon to reach the System Settings page.

3 Under the Audio box, select Headset Volume and adjust the 
volume. 

Disconnection When communication is over, deactivate the Talkset function on the 
2000 Platform. This deactivation can be done by either 2000 Platform.

Then, the fiber used for Talkset, can be disconnected from each Platform 
safely.

NOTE

The talkset icon is displayed on the top banner as long as communi-
cation remains established, letting the user know that the connection 
is working.
When communication is established, the headset is automatically 
enabled if plugged in. However, the loud speaker must be correctly 
configured in the setup menu to work accordingly 
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Chapter 6 Scope

The scope function is a hot-plug feature enabled directly when inserting 
a JDSU scope supplied as an accessory (see "References of accesso-
ries" page 76).

The topics discussed in this chapter are as follows:

– "Scope feature" page 36

– "Installation of tips" page 36

– "Configuring the P5000 Scope" page 37

– "Starting up with the scope" page 39

– "Launching a test of the connector and fiber end-face" page 40

– "File menu" page 43
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Scope feature

Overview This feature enables you to verify that your optical connectors are in 
perfect shape and very clean condition.

The  P5000 Digital Probe Microscope is a portable handheld microscope 
used to view and inspect both the bulkhead (female) and patch cord 
(male) sides of fiber connectors as well as other optical devices, such as 
transceivers.

The P5000 requires an FBPT inspection tip and is connected to the 2000 
Platform with a USB 2.0 connector.

Installation of tips
The Pass/Fail analysis function on the 2000 Platform can only be used 
with certain inspection tips mounted on the P5000.

Fig. 16 P5000 Probe components

QuickcaptureTM button
Instantly captures the image

Focus Control

Latch lock
Squeeze both ends to release

Barrel assembly USB 2.0 
connector

6 FT COIL Cable

Inspection tip

Fig. 17 Use of tips

Standard patch 
cord tips

Standard 
bulkhead tips

Barrel assembly

Pass / Fail results
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Configuring the P5000 Scope

Scope
connection

1 Plug in your JDSU scope into a USB port from the 2000 Platform.

2 Push the button HOME

3  Validate the Scope function .

4 Connect probe with the fiber being inspected.

You may select this option while other options are already selected (e.g. 
OTDR).

Configuring the
Scope

1 Press Setup key to configure the test.

The following screen displays:

Test On the line Profile, select the Profile which will be used for the test of 
fiber connector:

– IEC SM-UPC: Pass/Fail criteria for single-mode UPC connectors 
from IEC 61300-3-35 standard.

– IEC SM-APC: Pass/Fail criteria for single-mode APC connectors 
from IEC 61300-3-35 standard.

Profiles contain the analysis parameters by which PASS/FAIL criteria are 
determined.

Once the line is selected, you can also add a new profile, clicking on the 
Add Button (see "Adding a new profile" page 38).

Fig. 18 P5000 Scope Setup
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Report The parameters in Report box allow to configure the Report page setup.

On the line Company, enter the name of your company using the edition 
keypad.

On the line Logo, you can select an image on the 2000 Explorer once 
clicking on the right arrow key, which will be displayed on the upper left 
part of the report. Press the SETUP key to return back to the Setup page.

On the line Operator, you can enter the name of the operator, which will 
be displayed on the header of the report.

See Figure 22 on page 44 for a description of the pdf report.

Fiber The Fiber box allows to configure the fiber plugged to the scope.

On the line Fiber Name, use the edition keypad, which will display by 
clicking on the right arrow key, to enter a specific name for the fiber.

On the line Fiber Number, use the numeric keypad, which will display by 
clicking on the right arrow key, to enter the fiber number.

Press Exit to return to the Results screen of the scope.

Adding a new
profile

Once the Setup screen of the scope is displayed, you can add a specific 
profile which will be used for the test.

The profile must be created via FiberChek2TM, and stored on one 
storage media of the MTS/T-BERD 2000 (disk, or USB memory stick).

1 On the Setup screen, select Profile and press Add key.

2 On the explorer, select the file which will be used as profile (icon 
 ; extension: .PRO)

3 Press Load. 

Once loaded, the display goes back automatically to Setup screen.

4 Select the profile just loaded.

Removing a profile

1 In the Profile list, select the profile to be deleted.

2 Press Remove key., then Exit.
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Starting up with the scope
Once the FiberScope icon is validated:

1 Press RESULTS hard key

Luminosity and
Contrast
settings

Luminosity and contrast may be set manually by using the 
key Bright/Cont.. Once you select which parameter you 
wish to modify, use the arrow keys  and  to tune the 
luminosity or contrast to the desired value. Note that the 
set values are displayed on the key.

You may also choose to use the function Auto Contrast in 
order to get settings calculated automatically by the instru-
ment.

Fig. 19 Example of the result using the P5000 scope

NOTE

Saturated parts of the picture appear in yellow. Modify the luminosity 
and contrast settings or use Auto contrast to modify the actual set-
ting and remove saturation.

Auto Contrast must be used with a pristine (perfectly clean, 
undamaged) fiber connector. Changing the brightness or 
contrast settings can significantly change the fiber inspection 
test result.
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Freeze mode Once the image is acceptable (sharpness, luminosity and contrast are 
tuned correctly), you may freeze the picture. This feature allows to store 
in memory the resulting picture.

Adding a comment

A key Comment allows you to enter/modify a comment to your picture if 
necessary. This comment appears at the bottom left of the picture. 

The right bottom of the frozen picture also contains the date of the acqui-
sition (where the picture was frozen).

Camera mode Set the key Camera/Freeze on Camera, to get a live picture of the scope 
result.

Launching a test of the connector and fiber end-face

Launching a
test of the

connector and
fiber end-face

Once the Brightness and Contrast parameters are correctly defined for 
the current image (see "Luminosity and Contrast settings" page 39), a 
test of fiber connector can be launched.

The High mag./Low mag. key allows to display the picture with a high 
or low magnitude.

To launch the test:

1 Press Test key to launch the test of plugged fiber connector.

Freezing a scope result does not store the picture in a file (see "File 
menu" page 43). The result will be lost if the instrument is shut off, or if 
more than 3 pictures are frozen (see "Mosaic Mode" page 42).

NOTE

The button set on the lead, or the QuickCapture™ on the P5000 
allows to freeze the picture or to take a snapshot.

NOTE

Both the comment and the date will be saved with the picture.

Use the focus control to adjust the focus of the image
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The test is completed:

– once the Led Testing is no more lit in red

– once the icon   is no more displayed on the upper banner

– once a screen as the following one displays:

A summary of test results is displayed on the right, upper part of the 
screen.

– Zone A: represents the Core zone: it is the area 
surrounding the core

– Zone B: represents the Cladding zone. It 
surrounds the majority of the fiber cladding.

– Zone C: represents the Ferrule zone: it identifies 
a portion of the ferrule near and around the fiber

NOTE

To configure the Pass/Fail critera, refer to “Configuring the Scope” on 
page 37.

Fig. 20 Test results

Test result in 
High mag.

Profile selected 
in the Setup page Summary of 

Test results

Zone C

Zone B

Zone A

NOTE

To return to a Live Camera image, press the Camera/Freeze key; or 
press the Full Screen/Mosaic key view both the live image and a test 
result simultaneously.

In Mosaic mode (see "Mosaic Mode" page 42), the result of the test 
only displays Pass or Fail information; the status of each zone is dis-
played only in full screen mode.
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Mosaic Mode It is possible to display only one picture in full screen (640 * 390 pixels) 
or up to four pictures (320*180 pixels each, including the live camera 
picture) in mosaic mode. Use the key Full scr./Mosaic to switch from 
one mode to another.

– You may select one of the pictures by clicking on it.

The selected picture is framed in green.

The toolbar on the right varies according to which picture is selected 
(camera, or static picture):

Picture selected: Camera

All the Contrast and Luminosity settings are available just like in full 
screen. 

Snapshot The live picture from the camera is frozen but does not
replace the live picture at position 1. The new snapshot
is placed at the second position, and all existing pictures
are pushed to the next position. 

Fig. 21 Mosaic mode

Position 1 :

LIVE CAMERA

Position 2:
Snapshot saved on disk : connector cleaned

Position 3 : 
Connector before 
being cleaned

Position 4 : Regular JPEG image

Selected picture

If all positions were taken, the picture that was once at the fourth posi-
tion is unloaded from memory. Frozen pictures and snapshots are 
lost, unless they were saved on the internal memory.
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Loading a
picture

It is possible to retrieve and load a picture stored in the Scope directory 
and display it in the Scope page.

1 Press the FILE button.

2 Select Load. 

3 Select the JPEG file to be loaded via the Explorer

4 Click on Load >Confirm Load

Recognized pictures are images resulting from the Scope option and 
saved on disk via the 2000 Platform.

Even though the JPG editor of the Scope function has been designed to 
display Scope pictures in black & white, it is also possible to open any 
JPG valid file and display in color the corresponding picture. That picture 
is enlarged or shrunk to the size of the display (full screen or mosaic, 
see."Mosaic Mode" page 42).

File menu

Saving the test
result in a jpg

file

Once the test has been performed, and the result is displayed on the 
2000 Platform screen:

1 Press FILE key

2 Click on Save key to save a jpg file of the test result on the disk of 
the 2000 Platform.

3 On the edition keypad, enter the name of the jpg file

4 Press Enter to validate.

The file is automatically saved on the disk, in the directory Scope 
(icon ).

Generating a
report

1 Check the correct test result is selected (framed in green in mosaic 
mode)..

2 Press the FILE button, then the Report key

3 On the edition keypad, enter the name of the pdf file and press 
ENTER.

Some pictures resulting from the Scope option may appear 
nevertheless unrecognized, if they have been stored with a 
different Scope application, or if the JPG file has been opened 
and modified under another JPG editor.
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The report generation is completed once the icon  is no more 
displayed on the upper banner.

Display of the report

Once the report has been generated:

1 Return to the HOME page, and select the File Explorer

2 Select the pdf file of the report in the directory Scope.

3 Press Load > Confirm Load.

NOTE

The pdf report will be saved on the disk, in the directory Scope.

Fig. 22 PDF report

Logo, company & operator 
name selected in the 
Setup page (see “Report” 
on page 38)
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Chapter 7 File management

The files management with the 2000 Platform can be performed, wether 
a module is set onto the 2000 Platform or not.

The topics discussed in this chapter are as follows:

– “File Explorer Overview” on page 46

– “Directories and Files selections” on page 46

– “Directories & Files editing functions” on page 47

– “Working with directories and files from the explorer” on page 48

– “Creating a screenshot” on page 55

– “Creating a report” on page 56

– “Merging pdf or txt files” on page 58

– “Storage media” on page 59
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File Explorer Overview
To reach the File Explorer page

– On the Home page, select the File Explorer icon.

The File Explorer page appears.

Directories and Files selections

Directory
selection

To select a directory from the explorer page:

1 Press on the directory that must be selected on the left of the 
screen.

The list of files the directory countains displays on the right side of 
the screen

The selected directory is underlined in blue

2 Click on the arrow at the left of the directory name, or press valida-
tion hard key  , to display the sub-directories if any.

Fig. 23 File Explorer page

Fig. 24 Directory selection

Selected directory

Sub-directory

Access to 
sub-directory
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Files selection To select one or several files from the explorer page:

1 Press on files that must be selected.

or

To select a list of files using the keys of the Platform:

a Select and validate the first file of the list (underlined in red)

b Set the cursor on the last file of the list (underlined in blue)

c Maintain the right direction key  pushed until all the files are 
selected.

or

Click on Select all menu key to select all files into the directory.

Directories & Files editing functions

Copy/Cut &
Paste files/
directories

To copy (cut) one or several files, or one directory, and paste them in 
another place:

1 Select the directory / the file(s) (see “Directories and Files selec-
tions” on page 46).

2 Press Edit menu key

3 Press Copy to keep the directory / file(s) to their initial location.

NOTE

The last selected file is underlined in red and the previous one(s) 
selected is/are undelrined in blue. 

Fig. 25 Example of files selection

Selected files

Selected 
directory
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or

Press Cut  to delete the directory / file(s) from their initial location

4 On the left of the screen, select the directory; or select the new 
storage media.

5 Click on Paste menu key.

Renaming a
directory / file

1 Select the directory / file to be renamed (see “Directories and Files 
selections” on page 46).

2 Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

3 Press Clear if you wish to delete the entire name

4 Enter a new name for the directory / file.

5 Click on Enter to validate the new name.

Deleting a
directory / file

1 Select the directory or file(s) to be deleted (see “Directories and 
Files selections” on page 46).

2 Press Edit > Delete.

A confirmation dialog box displays.

3 Press Yes to delete the selected directory or file(s).

Press No to cancel the deletion.

Working with directories and files from the explorer

Creating a
directory

To create a new directory from the explorer page:

1 Check the cursor is set on the left of the screen

2 Select the storage media into which the directory must be created

Fig. 26 Edition keypad for renaming file
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3 If you want to create a sub-directory, select the directory into which it 
must be created.

4 Press the right menu key Create Directory.

The edition keypad displays

5 Enter a name for this directory

6 Press Enter key to validate the new directory

Opening files Once a file is selected, press Load, then Confirm Load menu keys.

File Types For files recognized by the 2000 Platform, the types are symbolized by 
icons. E.g.

Opening several files at  the same time can be done exclusively 
with trace files (example: all OTDR trace files if a reference trace 
has been defined). Other type of files (PDF, TXT ...) must be open 
one by one.

If different types of files have been selected in the Explorer, only 
the last one selected will open.

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension)

OSA file (.OSA extension)

Power Meter file (.LTS extension)

Icon Type of file

HTML file (.HTML extension)

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

CSV file (.CSV extension)
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Sorting files Wether files are selected or not, the key Sort allows to access to a sub-
menu allowing to sort te file accorfing to pre-defined parameters:

– Sort by name: the files display in an ascending order (from A to Z). 
If you click once again on the key, the files display in a descending 
order (from Z to A).

– Sort by size: by cliking once on this key, the files display from the 
smallest to the heaviest one. Clicking a second time allows to sort 
the files in opposite order.

– Sort by type: clicking once on this key; the 2000 Platform displays 
files in an ascending order (the file type A to file type W). By clicking 
again, the 2000 Platform displays the files in opposite order.

– Sort by date: clicking once on this key; the 2000 Platform displays  
files from the more recent to the less one. By clicking again on key, 
the Platform displays files from the older to the more recent one.

Transferring
files to a PC

If some Results traces or other kinds of file need to be transferred to the 
PC, this can be easily done using the USB cable delivered on standard 
with the 2000 Platform.

Establishing
connection 2000
Platform <-> PC

1 Connect the 2000 Platform to a PC, plugging the USB cable on the 
mini USB port of the Platform toward a USB port on the PC.

JPEG / JPG file (.JPEG extension)

PNG file (.PNG extension)

XML file (.XML extension)

Icon Type of file

With the 2000 Platform, you can open and load any kind of FO 
files (OTDR, OSA, PON, LTS) even if the corresponding module 
is not set into the Platform.

NOTE

You can also sort files clicking on the column titles in the files list
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2 Once connection is established, confirm that you wish to activate 
the USB link in the pop-up window on the 2000 Platform.

A message displays on the bottom right side of the PC informing a 
new hardware is detected.

3 Click on the message and select «Open folder to view files» in the 
dialog box JDSUDISK (F:) («F:» is an example, it can be different 
according to your PC and to the USB port used).

Fig. 27 Direct connection 2000 Platform <-> PC

Fig. 28 Confirmation of files export via USB cable

Mini USB Port on 
the 2000 Platform

USB port on the PC

USB cable
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The 2000 platform disk content opens onto the PC.

Transferring files
onto the PC

1 Select the file(s) from the 2000 Platform to be transferred onto the 
PC

2 Press Ctrl + C, or right click and select Copy.

3 On the PC, select the directory in which file(s) will be transferred.

4 Press Ctrl + V, or right click and select Paste.

Cancellng the
connection

Once all desired files have been transfer onto the PC, connection 
between 2000 Platform and PC can be removed:

1 On the PC, use the appropriate method to safely remove the USB 
cable from the USB port. 

The screen displays the results trace of the active function, or 
returns to the Home page if no function is active..

Fig. 29 Open 2000 disk content

Fig. 30 Files selection from the 2000 Platform
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2 Remove the mini USB plug from the 2000 Platform USB port.

Sending files by
Bluetooth

The Bluetooth option allows file transfers between the 2000 Platform and 
another device.

Setting up a
Bluetooth

connection

1 On the Home page, press System Settings key

2 Under I/O interfaces, select Bluetooth > Enable

The icon  is displayed on the upper banner of the screen

3 Push the Bluetooth Pairing menu key 

The Paired Bluetooth screen appears

4 Do one of the following:

Press the Become Pairable soft key to wait for another device to 
initiate the connection to the 2000.

or

If the desired device is not displayed on the screen, or if no devices 
are detected, press the Search Devices soft key.

The 2000 Platform is searching for the devices which could be used 
via Bluetooth with the equipment.

A baragraph is displayed during research  

Once the research is completed, a list of the available devices is 
displayed, with the level of detection of the 2000 Platform.

REMINDER
You may need to activate bluetooth on the other device to allow 
pairing.

Fig. 31 List of devices found

Level of detection
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a Select the device to be paired with the Platform underlined blue

b Push the Pair key to connect the device to the Platform

5 If prompted, enter a pairing code. The code must be identical on the 
2000 Platform and the device.

6 Once the bluetooth device and the Platform are paired, a screen is 
displayed with the description of the device

The icon has a blue background when paired with a device ,

You can now go to the file explorer and transfer files from the 2000 Plat-
form toward the bluetooth device and vice versa.

Transfering files
via Bluetooth

Once the connection has been established with a bluetooth device:

1 Go in the File Explorer.

2 Select the file(s) to be transferred from the Platform toward the PC.

3 Press Export menu key.

4 Push Export > Send by Bluetooth menu keys .

A confirmation message displays once the transfer is completed.

Fig. 32 Device paired with Platform

Fig. 33 Confirmation of files sending
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You can also transfer file(s) from the bluetooth device toward the Plat-
form.
In this case, the files received will be stored in a storage media created 
automatically on the Platform: bluetooth-inbox.

Removing the
Pairing

1 To remove the pairing between the two equipments, in the System 
Settings page, push the Bluetooth Pairing key

2 In the screen displayed, push the Remove pairing key

The icon on the upper banner of the screen becomes  showing the 
Platform is no more connected to a bluetooth device, but the Bluetooth 
option is still active.

To deactivate the bluetooth onto the Platform, go in the System Settings 
page, and under I/O Interfaces, select Disable on the Bluetooth line.

Creating a screenshot
You can create captures of what is displayed on the screen, directly from  
the 2000 Platform.

Configuring the
parameters of

screenshots

To configure the  screenshot and choose the format of the generated file:

1 Press HOME hard key

2 Select the Settings icon to reach the System Settings page.

3 In the Report box, on the line Mode, select Screenshot

Choosing this option, you can save the displayed screen in JPG, 
PNG or PDF format, exactly as it is displayed on the screen.

Therefore, if you make a zoom on the trace for example, the file will 
only show the zoom section.

4 On the line File format, select if the printed file will be a JPG, PNG 
or PDF file.

Taking a
screenshot

Once the screenshot parameters are configured:

1 Reach the display which will be saved as a screenshot in a file.

WARNING
The files stored in bluetooth-inbox will be lost once the 2000 
Platform is switched off. Move the files to keep toward another 
storage media (disk, usb key...).
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2 If necessary, make modifications on this display (example: zoom on 
trace...)

3 Press simultaneously the left and right arrow keys   for 
about 5 seconds

or

Click on the upper banner of the screen and, in the virtual control 
buttons bar, press Export key 

The icon  displays until the end of process.

4 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

Name of the
screenshots

files

The screenshot is saved in a file, which is automatically named as follow: 

– Print_date (year/month/day)_time (hour/minut/second).jpg/png/pdf

The file is saved in the directory Print, on the storage media disk.

Creating a report
Once the results page of a function is opened (example: OTDR trace, 
Power Meter results...), it can be exported in a report, using the 2000 
Platform.

Configuring the
report

To configure the report and choose the format of the report file:

1 Press HOME hard key

Fig. 34 Example of screenshot, open in the Web Browser of 
the 2000 Platform
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2 Select Settings icon to reach the System Settings page.

3 In the Report box, on the line Mode, select Report.

Choosing this option, you can save the open file in a JPG, PNG or 
PDF file report, exactly as if the file was printed on paper. 

Therefore, if the file is too large for one A4 page, several JPG, PNG 
or PDF files will be created.

4 On the line File format, select if the report file will be a JPG, PNG or 
PDF file.

5 To display a Logo on the upper right of the report pages, click on 
Logo line and select the Logo to be displayed on the upper right of 
the page: 

a Press  to open the edition keypad

b Enter the path of the logo file (example: disk/jdsu logo.jpg)

c Press Enter to validate.

Creating the
report

1 Open the file to be saved in a report in JPG, PNG or PDF format

2 If necessary, make the modifications on the file/trace (see user 
manual of the 2100 OTDR Modules for OTDR trace files).

3 Set the trace view as wished.

For OTDR traces

– if the function is set to the Trace mode (Trace is selected on the 
menu key Trace/Table/Summary), the JPG/PNG/PDF file will 
countain the header and the trace (in one page).

– If the function is set to Table mode (Table is selected on the 
menu key Trace/Table/Summary), the JPG/PNG/PDF file will 
countain the header, the trace and the entire results table 
(several pages may be required)

– If the function is set to Summary mode (Summary is selected 
on the menu key Trace/Table/Summary), the JPG/PNG/PDF 
file will countain the header and the summary page, with either  
the Bend table or the Alarm Table according to the selected item 
with the menu key.

This view is only available with OTDR traces.

Fig. 35 Example of Report configuration
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4 Click on the upper banner of the screen and, in the virtual control 
buttons bar, press Export key 

The icon  displays until the end of process.

5 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

The files are saved in the directory Print, on the disk media 
storage.

Name of the
report

If a trace has been saved in a report file, the name of the JPG/PNG/PDF 
file is as follow:

– name of the stored trace_date (year/month/day)_time (hour/minute/
second).jpg/png/pdf

Merging pdf or txt files
In the Explorer page, two pdf files or more, generated via the results 
traces can be merged in one pdf file.

– The pdf files that can be merged are those generated via the Fast 
Report key on trace results page (see “Creating a report” on 
page 56)

NOTE

If several traces are displayed in overlay, a different report file is gen-
erated for each trace open.

Fig. 36 Example of report (in pdf)
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– The txt files that can be merged are those saved with the results 
trace (see OTDR Modules User Manual: E2100M02)..

1 In the Explorer, select the two or more pdf/txt files generated

2 Press Export menu key

3 Press Merge key

The icon  is displayed during merging process.

After a few seconds, the files are merged in one pdf/txt file, which name 
by default is: merged_year_month_date__hour_min_sec.pdf 

The file is automatically saved in the same directory as the one where 
files have been selected.

It gathers all results from pdf/txt files selected (and traces for pdf file), in 
one single pdf file of several pages (1 results screen per page, if the 
results table does not exceed one page).

Storage media
For saving or recalling data, the 2000 Platform offers a wide choice of 
media, both built-in and external.

Free space on selected media is clearly displayed at the bottom of the 
left panel.

Fig. 37 Files selection and Merge key

NOTE

Once merged file is saved, it can be renamed in the Explorer (see 
“Renaming a directory / file” on page 48).
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Storage media
built into the

2000 Platform

The 2000 Platform is delivered with an internal memory , which maximum 
capacity is of 1GB (with a minimum of about 128 Mb are available for 
data storage).

External USB
storage media

The 2000 Platform is equipped with 2 USB ports as standard. One of 
these can be used to connect an external storage medium, in particular 
a USB memory stick.

USB memory stick
connection

1 Insert the USB memory stick in one of the 2000 Platform's USB port. 

A sound is emitted to confirm the successful insertion and recogni-
tion of a USB memory stick.

Then, the icon  is displayed in the upper banner to inform the 
user the USB stick is ready to be used.

USB memory stick
disconnection

1 Before disconnecting the USB memory stick, always select a 
storage device different from usbflash (select disk for example) in 
the explorer. 

2 Make sure you no longer have any running applications using the 
usbflash storage media.

3 The user must push the EJECT USB key, available in File Explorer.

The icon becomes  to indicate it can be removed safely. In this 
state, the USB stick cannot be used anymore

The USB memory stick can then be disconnected from the Platform USB 
port.

NOTE

Although two USB ports are present, it is not possible to use simulta-
neously more than one external USB storage medium. 

When a file is moved in the explorer of the Platform, the end of 
the move on the screen does not mean that writing of data into 
the memory is complete. Some data may still be in a writing 
process if the storage unit is removed prematurely. 

NOTE

The USB memory stick can also be removed using the Expert Tools 
> Media Utilities menu, accessible via the System Settings page.
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See Chapter 11 “Maintenance and Troubleshooting” if any problem 
occurs with the USB memory stick

Abbreviations
for storage

media

The abbreviations used in the explorer for the different storage media 
are:

Abbreviation Storage medium

disk Internal flash memory

usbflash USB memory stick

bluetooth-inbox Bluetooth storage media (option)a

a. The files stored in bluetooth-inbox are lost when the Platform is 
switched off.
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Chapter 8 Transferring the 2000 
Platform Interface

The 2000 Platform can be used in combination with a PC in order to 
transfer the Platform Interface onto a PC, or to access the internal 
memory or USB memory stick contents on the PC. 

Topics described in this chapter are as follows: 

– “Establishing connection” on page 64

– “Transferring the Interface” on page 66

– “Virtual control buttons bar” on page 67

– “Equivalence between the keyboard and 2000 Platform” on page 67
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Establishing connection
The connection between 2000 Platform and the PC can be done directly, 
or via a local network.

The transfer of the interface can be done using a VNC window on PC.

Connecting the
2000 Platform

and the PC

1 Connect the 2000 Platform to the PC via an Ethernet cable, using 
the RJ45 connectors set on both equipments.

2 Check the network connection on the PC is set in Dynamic mode.

Configuring the
2000 Platform

1 In the Home page of the 2000 Platform, validate the Settings icon.

2 In the System Settings page, in the I/O Interfaces box, configure 
the following parameters:

Ethernet > Mode

Parameters of the local Ethernet network to which the 2000 Platform is 
connected:

Config 1 to 4 static mode enabling input of the configuration of
4 sites. If this parameter is selected, the folowing
parameters must be entered:

– Site Name the user can enter the name of the site in the Edit 
menu.

For an intensive use of the deport screen or when it is used via a 
WAN network, it is strongly recommended to use a dedicated 
VNC client. The VNC clients recommended are Tight VNC (V 1.2.9 
or later) and Real VNC (V 4.1.1 or later).

Fig. 38 Connection 2000 Platform and PC
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– IP Address IP address of the 2000 Platform

– IP Mask address of the mask of the sub-network

– IP Gateway IP address of the machine enabling access outside 
the sub-network.

– DNS1 IP address of the machine providing the IP 
address on the basis of the name

– Domain name name of the local network to which the 2000 Plat-
form is connected.

Dynamic in this mode, which requires a DHCP server, the
2000 Platform requests an IP address from this
server which will be allocated dynamically if
dynamic host configuration is activated on the
local network.
After selecting this mode or after power-on, the
2000 Platform tries to establish a connection to
obtain an address from a DHCP server. If for any
reason, this process fails, the 2000 Platform
reverses to static IP address mode with User1 IP
address.

Proxy > Use proxy

1 Select No if no proxy is used.

2 If Manual has been selected, enter the Proxy Address.

3 If Auto has been selected, enter the Pac Address.

4 Note the IP Address displayed in the System Settings page.

5 Wait about 10 seconds the connection is established.

The 2000 Platform Interface can now be transferred onto the PC, or the 
internal memory or USB key ocntents can be transferred on PC..

1.Domain Name Server

NOTE

Once the 2000 Platform is connected to the network, the icon   
indicates the connection is working.

Fig. 39 Example of configuration for I/O Interfaces box

Note the 2000 Platform 
IP Address
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Transferring the Interface
Once the connection is established between the 2000 Platform and the 
PC, proceed as follow:

1 Open Internet Explorer on the PC.

2 Considering 10.33.18.93 is the IP Address of the 2000 Platform 
(as shown Figure 39 on page 65), enter the following address in the 
Internet Explorer window:

http://10.33.18.93:5800

3 Press Enter to validate.

A VNC window opens, demanding a 
password 

4 Press OK without typing any password.

The screen of the 2000 Platform appears offset on your PC.

You can use keyboard mouse of the PC to control the 2000 Platform (see 
“Equivalence between the keyboard and 2000 Platform” on page 67).

Fig. 40 VNC window

Click to install TightVNC software 
on your PC (not mandatory) 

NOTE

Once Remote screen is accessbile via VNC, the icon  displays 
on the upper banner of the screen until the connection is cut or the 
2000 Platform is switched off.
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Virtual control buttons bar
It is possible to emulate hard keys with Virtual Control buttons. This 
virtual control buttons bar is especially useful when the 2000 Platform 
screen is exported on a remote PC.

To display those buttons, click once on the top of the screen in the status 
bar, at the same height than the date and time.

The virtual control buttons bar is displayed during a few seconds. You 
may click on any of these buttons to obtain exactly the same results than 
using the hard keys on the front panel of the 2000 Platform.

Equivalence between the keyboard and 2000 Platform
The PC keyboard can replaced all the buttons and keys of the 2000 Plat-
form except the ON/OFF button: 

– The menu keys to the right of the screen are replaced by the func-
tion keys F1 to F6.

– The buttons below the screen are equivalent to Ctrl + a letter (see 
table below).

– The direction keys have the same function on the external keyboard 
and on the 2000 Platform.

Fig. 41 Virtual control buttons bar

Function on the 2000 Platform External keyboard 

HOME Ctrl + H

SYSTEM SETTINGS F12

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORT Ctrl + Pa

¬  -  ®  ¯

Menu keys 1 to 6 (from top to bottom) F1  F6

ABOUT F11

Save and quit (Exit) Entrée/Enter
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Quit without saving (Abort) Escape/Echap.

a. The Export function is available directly on the 2000 Platform pushing 
simultaneously the left and right arrow keys.

Function on the 2000 Platform External keyboard 

NOTE

Those equivalences are also valid with a keyboard directly connected 
to the 2000 Platform via one USB port.
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Chapter 9 Technical specifications

This chapter contains the technical specifications of the 2000 Platform 
mainframe.

The topics discussed in this chapter are as follows:

– “Display specifications” on page 70

– “Memory” on page 70

– “Input/Output” on page 70

– “Power supply” on page 70

– “Dimensions - Weight” on page 71

– “Environment” on page 72

– “Characteristics of the options” on page 73
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Display specifications

Screen – Backlight color touchscreen

– Size: 5 inches 

– Resolution: 800 x 480 pixels

Memory
– Standard memory: internal memory, with a capacity of 1GB (with a 

minimum of about 125 Mb are available for data storage).

Input/Output
– two USB 2.0 host ports.

– one Mini USB 2.0 device

– one RJ 45 connector for Ethernet interface 10/100/1G

– built-in loudspeaker 

– headset jack

Power supply

Battery The instrument can be supplied with one Li-Polymer battery.

Endurance of the 2000 Platform with battery

Measurement conditions:

– at +25 °C, 

– at full battery capacity (4.5 Ah), 

– 2000 Platform equipped with one OTDR LM module

2000 Platform English rev00.book  Page 70  Lundi, 20. juin 2011  1:47 13



Chapter 9 Technical specifications
Dimensions - Weight

User Manual 790000002/00 71

Endurance

Mains adapters

Supply or Power assigned in AC and in DC: 25 W

Dimensions - Weight

Endurance

Conditions of use Li-Polymer battery

According to Telcordia GR-196-CORE recommendation:
Normal conditons, with normal backlight, 3 acquisition of 
30 seconds per quarter of hour, auto off

up to 8 hours

Under continuous acquisition, with high screen backlight :
- with an OTDR QUAD Module
- with an OTDR LM Module

Up to 3h
Up to 3h45

Standard Mains Adapter

Input 100-250 V, 50-60 Hz

Output 12V DC 2.5 A max

Compliance EN 60950

Weight

2000 Platform without options, battery nor module 692 g 1.52 lbs

2000 Platform with a Li-Polymer battery and one 
OTDR LM Module

1.21 kg 2.67 lbs

Li-Polymer battery 172 g 0.37 lbs

VFL/PWM option 30 g 0.066 lbs

Dimensions (mm)
( H X W X D )
Bumpers included

Dimensions (mm)
( H X W X D )
W/o bumpers

Without module 175 x 138 x 41 169 x 134 x 39

With 1 module 175 x 138 x 80 169 x 134 x 39
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Environment

Temperature

Humidity – 5 to 95% without condensation

Climatic
pressure

– Climatic pressure: 4000 meters

EMI/ESD – CE class B Compliant (EN61326-1)

– FCC 47-1 Part 15 Compliant

Electrical
Safety

– EN 61010-1: 2001 Compliant

Drop test In accordance with the Telcordia GR-196-CORE recommendations, the 
2000 Platform resists the following test: 

– 6 impacts dropped from a height of 1m on a pinwood floor of 5 cm 
thickness (1 impact on each of its 6 sides, with power off).

Shocks The 2000 Platform resists the following test:

– 3 shocks per axis along each of the 3 axes, with power off.

– Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

Bumps The 2000 Platform resists the following test: 

– 1,000 bumps per axis along each of the 3 axes, with power off.

– Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

– Operating temperature range -20°C to +50°C (-4°F to +122°F)

– Operation including all options 
(guaranteed specifications)

0° to +40°C (+32°F to +104°F)

– Storage -20C to +60C (-4°F to +140°F)
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Vibration The 2000 Platform resists the following vibration tests:

– Complete test comprising 6 cycles along each of the x, y and z axes.

– One cycle of 5 to 200 Hz and back to 5 Hz with a sweep duration of 
one minute/octave.

– 3 mm amplitude displacement test, for the range 5 Hz to 15 Hz.

– 3g acceleration test for the range 16 Hz to 200 Hz.

Flammability The 2000 Platform housing (in ABS, type V0) does not propagate fire.

Characteristics of the options

Power meter
option

Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

– Wavelength range: 800 to 1650 nm in steps of 1 nm

– Calibrated wavelengths: 850 / 1310 / 1490 / 1550 / 1625 nm

– Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)

– Input power range : -60 dBm to +10 dBm

– Maximum resolution: 0.01 dB / 0.01nW

– Measurement range:+5 to -50 dBm (-45 dBm from 800 to 1250 nm)

– Linearity within the measurement range: ± 0.2 dB

VFL – Wavelength: 650 nm

– Length of fiber: up to 5 km

– Class 2 laser (standards EN60825-1 and FDA21 CFR Part 
1040.10).

Bluetooth
Option

– Bluetooth Option

– Class 2

– Range: up to 10 meters
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Chapter 10 Options and accessories

This chapter shows the references of the options and accessories of the 
2000 Platform.

The topics discussed in this chapter are as follows:

– “References of options for the 2000 Platform” on page 76

– “References of accessories” on page 76

– “References of manuals” on page 77

– “References of result processing software” on page 77
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References of options for the 2000 Platform2

References of accessories

2.These options must be ordered together with the instrument.

Base Unit references Reference

MTS-2000 Handheld Platform with touchscreen EM2000T

T-BERD 2000 Handheld Platform with touchscreen ETB2000T

Power Meter / VFL / Wifi / Bluetooth options Reference

Optical Power Meter option for T-BERD/MTS-2000 Platform E20PM

Power Meter and VFL option for T-BERD/MTS-2000 Platform E20PMVFL

Power Meter and Talkset option for T-BERD/MTS-2000 Platform E20TSPM

Mains options Reference

Cigarette lighter adapter for 2000/4000 Platform E40LIGHTER

Battery Reference

Replaceable Li-Polymer battery (see “Changing the battery” on page 95) E20LIPO

Scope Reference

Digital Videoscope kit including FBP-P5000 probe (USB2.0) in a small 
soft case, and 7 tips in a box

EDFSCOPE5K

Carrying Cases References

Hard carrying case for the MTS/T-BERD 2000 and various accessories E20HCASE1

Large Soft Case for MTS/T-BERD 2000/4000 Platform E40SCASE1
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References of manuals

References of result processing software3

User manual for 2000 Platform Reference

Printed User manual for 2000 Platform (French) E2000M01

Printed User manual for 2000 Platform (English) E2000M02

Printed User manual for 2000 Platform (German) E2000M03

NOTE

The User Manuals for MTS/T-BERD 2000 (Platform & Modules) are 
available in pdf format, into the unit.

The printed versions of the manuals are available on option, in 
French, English and German.

3.Free software updates on the Web (but without user manual)

Reference

Optical Fiber Trace software EOFS100

Optical Fiber Trace software (5 licences) EOFS1005L

Optical Fiber Trace software (site licence) EOFS100SL

FiberTrace software - update EOFS100UP

Optical Fiber Cable software EOFS200

Optical Fiber Cable software (5 licences) EOFS2005L

Optical Fiber Cable software (site licence) EOFS200SL
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Chapter 11 Maintenance and 
Troubleshooting

This chapter describes how to maintain your unit and identify and correct 
problems related to the 2000 Platform.

The topics discussed in this chapter are as follows:

– “Maintenance procedure” on page 80

– “Recycling Information” on page 92

– “Troubleshooting” on page 92

– “General information on warranty” on page 97
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Maintenance procedure

Maintenance work on this instrument must only be undertaken 
by qualified personnel using suitable equipment.

In most cases, it is advisable to contact the nearest JDSU Service 
Centre, which will undertake the appropriate troubleshooting and repair 
work.
The performance and technical complexity of the 2000 Platform class 
this instrument in a new generation of equipment, for which JDSU has 
laid down a maintenance policy based on the principle of standard 
module replacement.
In implementation of this policy, we have set up powerful card trouble-
shooting test resources in our factories and a rapid dispatch system 
operating between our factories and branches.
Only by this procedure can the high quality of the instrument continue to 
be ensured after repair work. This procedure also has the advantage of 
reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adop-
tion of the following procedure in the event of a fault, before any other 
steps are taken:

– Verify that the instrument is plugged in.

– Check the connections of any peripheral equipment to the 2000 
Platform.

– If a fault is detected, or in case of doubt, it is advisable to contact the 
nearest JDSU Service Centre, which will undertake the appropriate 
repair work. 

Cleaning

Cleaning plates
and housings

The front and rear plates and the housings may become tarnished with 
handling. To clean them, use only a rag moistened with soapy water.

Never use any product containing acetone, trichloro-ethylene, benzine or 
alcohol, as these will attack the printed markings.

Cleaning the
screen

To clean the screen, use an antistatic product.
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Cleaning the
optical cable

connector

– Use a non-linting type of paper, such as Joseph paper, soaked in 
isopropylic alcohol.

– Pay particular attention to the polished face of the fiber, rubbing it in 
a direction perpendicular to the axis of the fiber.

Cleaning the
optical

connections of the
2000 Platform

– Squirt a highly volatile solvent (such as isopropylic alcohol) into the 
connector.

– Blow out the connector using a clean dry air supply from an aerosol 
can fitted with an extension.

Accessing to
the 2000
Platform

information

On the 2000 Platform, some screens allows to display information on 
different elements of the equipment.

To display the information on the 2000 Platform

1 On the Home page, validate Settings icon to reach the System 
Settings page.

2 On the right menu keys, press About to display the presentation 
screen of the 2000 Platform.

General page The General page is displayed by default, and allows to display the 
presentation screen, with all the information concerning the software 
versions, the hardware options and the module installed.

NOTE

If your module has a universal connector, unscrew its adaptor to 
access the ferule.

Fig. 42 General page
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This page shows:

– The software version information

– The product contents: base, optical options, battery type, module 
installed and date of calibration for options concerned.

The options set into the 2000 Platform are marked with a green tick.

Software options
page

This page allows to  visualize the software options available on the 2000 
Platform.

1 Once on the About screen, press Software Options menu key to 
display the list of software options available on your 2000 Platform.

Services Data page This page allows to display information about the elements inside the 
2000 Platform (CPU, Memory, hardware revision, screen reference...).

1 Once on the About screen, press Services Data menu key to 
display the list of elements countained on your 2000 Platform.

Fig. 43 Software Options page
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Accessing to
the 2000
Platform

documentation

All documents necessary for the 2000 Platform use are directly available 
onto the equipment.

To display the list of documents available for 2000 Platform use:

1 Validate the Help icon on the Home page.

2 Click on Link to PDF User Manual.

3 In the new page, click one link to display the corresponding docu-
ment: User manual, Getting Started Manual, Quick Card...

Fig. 44 Services Data page

Fig. 45 Help page
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Installing a new
version of the

software

Downloading from
Internet

When the software is obtained from the Internet, it must be saved on a 
storage medium before the software upgrade of the product can be 
carried out. To do this:

1 Open Internet Explorer

2 On the JDSU web site (http://www.jdsu.com), open the page of the 
product concerned

– MTS 2000 Multiple Services Test Platform

or

– T-BERD 2000 Multiple Services Test Platform 

3 Click on the tab Downloads.

4 Click on the link 2000 Firmware Update

A new page opens, displaying the current version available and 
several links.

5 Click on the icon  or on the exe file to load the archive.

6 In the new dialog box displayed, click on Save to save the exe file 
on the PC.

7 Once completed, connect the USB memory stick to the PC and 
follow the instructions chapter “Installation from a USB memory 
stick” on page 84, from step 2.

Installation from a
USB memory stick

You must be equipped with a USB memory stick with a minimum capacity 
of 128 Mo.

When a new software version is loaded, there is a risk of re-initializa-
tion of the internal memory. Before installing the new software, it is 
therefore advisable to save the results in the memory, using the Save 
function called up by the FILE button.

Do not interrupt the installation process, as this could damage the 
instrument.

To avoid any interruption of the installation procedure, the 2000 Plat-
form must be operating on the mains: if the procedure is started while 
operating on battery, a message indicates that the instrument must be 
connected to the mains.
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Before installing the upgrade, you must format the USB memory stick 
(see “Formating the USB memory stick onto the 2000 Platform” on 
page 94).

1 Once formated, disconnect the USB memory stick from the 2000 
Platform using the key Eject USB in the Media Utilities page.

2 Connect the USB memory stick to the PC

3 Unzip the upgrade files on the PC and transfer it to the USB memory 
stick:

a Download and save on your PC the .exe upgrade file that you 
can get from the web ( http://www.jdsu.com, see “Downloading 
from Internet” on page 84).  

b Once the transfer is completed, double click on the .exe file: A 
window  will appear. Check that the folder is correct i.e. the USB 
memory stick driver is appearing in the line at the bottom of the 
dialog box then press OK. If not, click on the icon  in order to 
select the right USB drive.

c Press OK and wait for the end of loading.

4 Then remove the USB memory stick, using the appropriate proce-
dure, from your PC

5 Insert the memory stick into one of the USB ports on the Platform.

As for any media formatting, please note that all data present on the 
USB memory stick will be irremediably lost.

Fig. 46 List of software update

NOTE

A bip is emitted each time the USB memory stick is inserted or 
removed from the USB port.
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6 Press the HOME button, then successively the Settings > Expert 
Tools > Upgrades > Software Upgrade > Upgrade from USB.

The message Are you sure? is displayed

7 Click on Confirm. 

The list of the software versions available on the USB stick is 
displayed next to the versions installed on the 2000 Platform.

8 Click on Show Prev choice or Show Next Choice to display the 
previous and next versions available.

9 Click on Confirm this Choice to start the upgrade of the selected 
software(s). 

or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The 2000 Platform is automatically rebooted. 
Upgrading takes several minutes. Finally, the 2000 Platform is auto-
matically restarted.

Installation from
Ethernet

Before starting the software upgrade via Ethernet, make sure the IP 
adress of the PC server.

The update can be performed directly onto the equipment, using an http 
address.

1 Connect the 2000 Platform to a PC via an Ethernet link.

2 On the Home page, press Settings key to open the System 
Settings page.

3 In I/O Interfaces, on the line Ethernet, select Mode: Dynamic.

4 In the Upgrade Server box:

– On the line Address Type, select Server name

– On the line Server Name, enter the address: 
2k.updatemyunit.net

NOTE

The software versions list does not always appear (cf previous ver-
sions) as well as the Previous / Next Choice buttons and the Con-
firm/Continue key. In this case, the upgrading starts automatically.

During the upgrade, the Testing indicator is lit in red. Do not 
push any button or remove the USB memory stick while the 
indicator is lit. The USB stick can be removed if necessary once 
the Testing indicator is off.
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5 In the I/O Interfaces box::

– On the line Use proxy, select No, Manual or Auto wether a 
proxy is used or not.

6 Once completed, press Exit to return to the Home page.

7 Press, in succession, Expert Tools > Upgrades > Software 
Upgrade > Upgrade via Ethernet.

The message Verify IP address of PC server appears. 

8 Click on Continue. 

The list of the software versions available on the PC is displayed 
next to the versions installed on the 2000 Platform.

9 Click on  Show Prev choice or  Show Next Choice to display the 
previous and next versions available.

10 Click on Confirm to start the upgrade of the selected software(s).
or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The 2000 Platform is automatically rebooted. 
Upgrading takes several minutes. At the end, the 2000 Platform is 
automatically restarted.

Upgrading from
the boot

This method is used to make a complete reinstallation of the software 
versions.

1 Turn off the 2000 Platform using the ON/OFF button, keeping the 
equipment connected to the mains.

Fig. 47 Configuration of the Upgrade Server

NOTE

The software versions list does not always appear (cf previous ver-
sions) as well as the Show Previous / Next Choice buttons and the 
Confirm/Continue key. In this case, the upgrading starts automati-
cally.

During the upgrade, the Testing indicator is lit in red. Do not 
push any button while the indicator is lit.
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2 Insert the USB stick onto which the software versions are stored into 
one of the USB port of the Platform

3 Press simultaneously SETUP + START/STOP buttons

4 Maintaining the two buttons pressed, press ON button to start the 
2000 Platform.

5 A menu is displayed, then the screen allows to select Upgrade from 
from USB

After a few seconds, a new page displays indicating that to continue 
the reboot, the validation key must be pressed.

Press the hard key  .

The reboot starts automatically.

Once the upgrade is completed, the 2000 Platform will automatically 
tunrs on and display the Home page.

Install Option This page allows to import the licence to get a software option.

The Testing indicator will be lit in red during upgrade. Do not 
push any key or remove the USB memory stick until the lit turns 
off.

Fig. 48 Example of a License file (.lic)

Licence Code
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To import the license, you can either enter manually the licence code, 
given in the license file, (.lic file) or import this file with a USB memory 
stick connected to the 2000 Platform.

Enter Manually the
Licence

1 In the Home page, click on Expert Tools > Upgrades > Install 
Option > Enter License

The edition keypad is displayed

2 Enter the challenge code of the option, set at the bottom of the file 
(see Figure 48 on page 88),

3 Press the Enter key to validate the code

Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . Confirm the reboot 
to restart the Platform.

Import the license
from the USB
memory stick

1 In the Home page, select the Settings icon

2 In the System Settings page, press Expert Tools > Upgrades > 
Install Option > Import License

It is strongly recommended to perform the installation using the 
importation of Licence via a USB memory stick.

Fig. 49 Enter the Licence code

The license file can be opened via a word processing software 
such as Word...
The challenge code must be entered exactly as it is in the .lic file, 
paying attention to the lower-case and upper-case letters etc.
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If the USB memory stick is not already connected to the Platform, a 
message asking the memory stick insertion is displayed. Confirm it 
once the stick is connected.

3 In the File Explorer, select the USB stick, then the license file (.lic) to 
be imported,

4 Click on Load > Confirm

5 The challenge codes contained in this file will then be loaded auto-
matically and your software options will be installed.

6 At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . 

7 Confirm the reboot 

Locking the
2000 Platform

The 2000 Platform can be locked at any time:

1 In the HOME page, click on Expert Tools

2 Click on Instrument Lock Out

3 Confirm the 2000 Platform locking by clicking on Confirm (or use 
the Cancel key to cancel the process).

The numeric keypad is displayed

4 Entrer the password to lock the instrument: 42000 with the numeric 
keypad displayed.

Fig. 50 License imported
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5 Click on Enter

The 2000 Platform locking screen is displayed.

Click on the Notepad Message key to add a message using the text 
edition.

Unlocking the 2000 Platform

1 Once the locking screen is displayed, click on the key Unlock 
Instrument.

2 Press confirm to confirm the Platform must be unlocked.

3 Enter the password 42000 using the numeric keypad displayed and 
validate.

The screen automatically displays the HOME page.

Fig. 51 Password

Fig. 52 Locking screen
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Returning an
instrument

When returning an instrument, it is essential to indicate the following 
minimum information:

– the type and serial number of the instrument (on the identification 
label) and the configuration code (under the bar code)

– a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee
conditions

Any repair operation supervening within the guarantee period of the 
instrument will be carried out at the expense of JDSU. However, for any 
sub-assembly upon which work has been carried out otherwise than by 
JDSU Service Centers, the cost of a replacement sub-assembly will be 
invoiced.

Recycling Information
JDSU recommends that customers dispose of their instruments and 
peripherals in an environnmentally sound manner. Potential methods 
include reuse of parts or whole products and recycling of products 
components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not 
be disposed of with household waste. Il should be deposited at an appro-
priate facility to enable recovery and recycling.

Troubleshooting

Interpreting
alarms

Troubleshooting Solution

Nothing happens when the ON/
OFF key is pressed.

- Make sure that the battery is present or charged; or 
the mains adapter is properly connected (see  “Con-
necting the mains adapter” on page 16).
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Nothing happens on screen, 
whatever is the action done 
(menu key or hard key pressed...)

- The Platform must be rebooted.
See “Resetting the 2000 Platform” on page 18.

You are using the 2000 Platform 
in the ordinary way when it sud-
denly switches off.

- Check the instrument is not configured to Auto off.
See “Defining the Automatic shutdown of the 2000 
Platform” on page 24). 
- Check the battery charge level.
See “Charging the battery” on page 16.

The battery refuses to charge (the 
Charge indicator does not go on 
when the instrument is connected 
to the mains and is not operating).

- There is no battery in the instrument.
- The temperature level of the equipment does not 
allow the battery charging for safety reasons. Wait 
the equipment cools down.
- The battery needs to be changed.
See “Changing the battery” on page 95.

When using the touchscreen, 
nothing happens

- The touchscreen needs to be calibrate.
See “Touchscreen calibration” on page 94

Error message when USB has 
been disconencted

- The USB disconnection has not been done prop-
erly (see “USB memory stick disconnection” on 
page 60)
- The data transfer was not completed when USB 
key was disconnected.

No beep is emitted when the USB 
memory stick is connected

- A previous USB memory stick has not been prop-
erly disconnected (see “USB memory stick discon-
nection” on page 60).
- The USB memory stick is not detected by the 2000 
Platform: use another memory stick, or another 
sotrage media; or transfer data via USB cable (see 
“Transferring files to a PC” on page 50).

Error message when upgrade via 
Ethernet is confirmed

- Check the Server Name is correctly entered (see 
“Installation from Ethernet” on page 86)

Error message when upgrade via 
USB key is confirmed

Check the USB key is correctly connected (see 
“USB memory stick connection” on page 60)

Error message when unlocking 
the instrument

- The password is not the correct one (see “Locking 
the 2000 Platform” on page 90).

Troubleshooting Solution
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Formating the
USB memory
stick onto the
2000 Platform

If the USB icon  is displayed on the upper banner of the screen, 
when a USB memory stick is connected to the 2000 Platform, this may 
means the memory stick must be formatted.

If the stick needs to be formatted, proceed as follows:

1 Insert the memory stick into one of the USB port on the top of the 
2000 Platform.

2 Press the HOME button

3 Validate the Settings icon to open the System Settings page.

4 On the right menu keys, successively select Expert tools >  Media 
utilities > Usbflash Format.

5 Confirm your choice to actually format the USB memory stick.

Erase disk To delete all the disk contents of the 2000 Platform:

1 On the Home page, Press twice the Settings icon to open the 
System Settings page

2 Press Expert Tools >  Media Utilities, 

3 Select Erase Disk  to delete all the disk contents into the 2000 Plat-
form.

A confirmation must be validated before the deletion.

Touchscreen
calibration

If you meet problems when using the touchscreen (example: pressing on 
an icon does not work correctly...)  a calibration can be performed on the 
2000 Platform touchscreen.

To calibrate the touchscreen, proceed as follows:

1 Push the HOME button

2 Press twice the Settings icon to open the System Settings page.

3 Press Expert Tools menu key

4 Press Touchscreen Calibration key

A blue slightly smaller screen appears, displaying a little target on 
the left hand corner . 

5 Click on this target (preferably with the touchscreen pen). 

6 A new target appears then and again, for a total of 4 times, in order 
to click on all corners of the screen.

As for any media formatting,  please note that all data present on 
the USB memory stick will be irremediably lost.
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If all the targets are not correctly touched, the touchscreen cannot be 
used. Otherwise, the touchscreen may be used directly.

Changing the
battery

If you meet problems during the Platform functioning, or if the battery 
does not charge anymore when plugged, this may require the battery to 
be replaced.

Accessing to the
damaged battery

To access the battery of the 2000 Platform, proceed as follows:

1 Switch off the instrument and disconnect the mains supply.

2 Turn the instrument face down on the work surface.

3 If  any, remove the module installed (see “Removing a module” on 
page 14).

4 Remove the battery door

5 Pull the battery connector from its housing, to disconnect it from the 
base, taking care not to damage the connector into which it is 
plugged.

Fig. 53 Touchscreen calibration

Target

CAUTION
Battery is not interchangeable in the field. It must be replaced 
exclusively for maintenance purpose.
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Installing a new
battery

1 Set the battery into the Platform

2 Connect the new battery in the connector of the 2000 Platform, in 
the right way using the location notch.

Fig. 54 Battery installation

 Battery door  Battery

Date and Time parameters will be lost when battery is 
diconnected.

Fig. 55 Setting a new battery
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Contact JDSU local Sales Service to get a new battery.

General information on warranty
The warranties described herein shall apply to all commercially available 
JDSU products. Any additional or different warranties shall apply only if 
agreed to by JDSU in writing. These warranties are not transferable 
without the express written consent of JDSU. 

Hardware
Warranty

JDSU warrants that Hardware Product sold to customer shall, under 
normal use and service, be free from defects in materials and workman-
ship. Information regarding the specific warranty period for this product 
can be obtained by contacting your local JDSU Customer Service Repre-
sentative, or at our web site www.jdsu.com. If installation services have 
been ordered, the warranty period shall begin on the earlier of (1) 
completion of installation, or (2) thirty (30) days after shipment to 
customer. If Installation Services have not been ordered, the warranty 
period shall begin upon shipment to Customer. Hereafter these periods 
of time shall be collectively referred to as the Initial Warranty Period.

JDSU ’s obligation and customer’s sole remedy under this Hardware 
Warranty is limited to the repair or replacement, at Acterna’s option, of 
the defective product. JDSU shall have no obligation to remedy any such 
defect if it can be shown: (a) that the Product was altered, repaired, or 
reworked by any party other than JDSU without JDSU’s written consent; 
(b) that such defects were the result of customer’s improper storage, 
mishandling, abuse, or misuse of Product; (c) that such defects were the 
result of customer’s use of Product in conjunction with equipment elec-
tronically or mechanically incompatible or of an inferior quality; or (d) that 
the defect was the result of damage by fire, explosion, power failure, or 
any act of nature.

When putting a battery back into its seating, make sure that its 
connector engages correctly with the one of the base and that 
the door is correctly closed.

Do not use any battery other than the one supplied with the 
instrument, or supplied by JDSU.
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JDSU performed repairs shall be warranted from defective material and 
workmanship for a period of ninety (90) days, or until the end of the Initial 
Warranty Period, whichever is longer. Risk of loss or damage to Product 
returned to JDSU for repair or replacement shall be borne by customer 
until delivery to JDSU.

Upon delivery of such product, JDSU shall assume the risk of loss or 
damage until that time that the product being repaired or replaced is 
returned and delivered to customer. Customer shall pay all transportation 
costs for equipment or software shipped to JDSU for repair or replace-
ment. JDSU shall pay all transportation costs associated with returning 
repaired or replaced product to customer.

Warranty
disclaimer

For hardware and/or services furnished by JDSU, the foregoing warran-
ties are in lieu of all other warrantees and conditions, express or implied. 
JDSU specifically disclaims all other warranties, either express or 
implied, on any hardware, documentation or services including but not 
limited to warranties relating to quality, performance, noninfringement, 
merchantability or fitness for a particular purpose, as well as those arising 
from any course of dealing, usage or trade practice. under no circum-
stances will JDSU be liable for any indirect or consequential damages 
related to breach of this warranty.
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switching off 18
switching on 17
troubleshooting 92

Power meter
alarm 28
attenuator compensation 27
connection 26
file management 32

measurement 31
reference 76
reference measurement 31
results 28
specifications 73
zero value 30

Power Meter file 49

Processing software
reference 77

R
Report 56

result 58

S
Scope

adding a profile 38
cladding 41
comment 40
core 41
feature 36
ferrule 41
freeze 40
load picture 43
luminosity & contrast 39
mosaic 42
removing a profile 38
report display 44

Screen
specifications 70

Screenshot 55

Services data 83

Software update
via Ethernet 86
via Internet 84
via USB 84

Storage media 59
abbreviations 61

T
Text file 49

Transfer interface
ethernet Mode 64
proxy config. 65
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U
Unpacking the instrument 2
USB

connection 60
disconnection 60
upgrade via 84

User manual
reference 77

V
VFL

connection 26
emission of light 32
function 31
specifications 73

X
XML file 50
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